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Abstract: Microsoft Word is a powerful word processing program.  This 
document explores the use the of Mail Merge utility by showing 
you how to create a form letter and merge mailing lists to create 
individualized letters. 
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Introduction 
Microsoft Word is a word processing program than can be used to create various types of 
documents from letters and memos to calendars and lists.  Features of Microsoft Word, 
such as Mail Merge, can be useful when creating generic documents to be sent to large 
numbers of people.  Microsoft Word also allows you to create and print labels or 
envelopes on your printer.   

Note: This handout is designed for Microsoft Word XP.  Much of the content 
will be the same if Word 97 or 2000 is used, however the steps to 
create a mail merge document are very different between previous 
versions of Word and XP.   

Objectives 
The goal of this workshop is to introduce participants to the Mail Merge functions of 
Microsoft Word. After today's workshop, participants will be able to: 

• Create and edit a main document and a data source for Mail Merge 

• Create and print envelopes using the Mail Merge tool 

Prerequisites  
The prerequisite is the Microsoft Word: Everyday Tasks workshop or equivalent skills. 

Related Training Available from Instructional Services 
All workshops offered by Information Services are free to KU students, staff, faculty, and 
approved affiliates.  

To learn more about or register for workshops, receive automatic announcements of 
upcoming workshops, and track workshops you’ve registered for and have attended, visit 
the www.lib.ku.edu/instruction.  You can also check our online schedule at 
www.lib.ku.edu/instruction/workshops for a list of class offerings and their availability. 
For further workshop related questions, please email training@ku.edu. 
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Definitions 
Term Definition 

Mail Merge Use the Mail Merge Wizard to create form letters, mailing labels, 
envelopes, directories, and mass e-mail and fax distributions. 

Main 
Document 

The document that contains the text and graphics that are the same for 
each version of the merged document, for example, the return address or 
salutation in a form letter. 

Data 
Source 

A file that contains information to be merged into a document.  For 
example, the list of names and addresses you want to use in a mail merge.

Merge 
Field 

A placeholder that you insert in the main document that instructs Word to 
insert text, graphics, page numbers, and other material into a document 
automatically.  For example, insert the merge field <<City>> to have Word 
insert a city name, such as “Lawrence,” that’s stored in the City data field. 

Mail Merge 
Mail merge is a process of combining generic 
information (such as a form letter or mass email) with 
specific information (such as a specific recipient’s 
address, name, or title).  In Word, this process is 
completed using two components: a main document (for 
example a form letter you want sent to a number of 
people), and a data source (a list of recipients that 
includes names, addresses, phone numbers, titles, etc.).  
This data source could be an email address book, a 
Microsoft Excel spreadsheet, a database, or various 
other files.  The main document contains standard text 
that all final letters will contain, but it also contains 
variable placeholders, such as the “Address Bock” or 
the “Greeting Line”.  These generic placeholders are 
replaced with the specific information for each recipient 
obtained from the data source records.   

Creating a Mail Merge using the 
Wizard 

1. Click the Tools menu, point at Letters and 
Mailings, and select Mail Merge….  The Mail 
Merge task pane appears.   
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Step 1 

2. Under the Select document type section, click Letters or choose which type of 
document you will be creating.  The active document becomes the main document, 
even if the active document is blank. 

3. Click Next: Starting document at the bottom of the task pane.   

Step 2 

4. Under the Select starting document section, choose how you want to set up your 
letter. 

• Use the current document – Start with the document currently shown in the 
document window.  You can then either type the letter in the document window, 
or wait until the wizard prompts you to do so in a later step. 

• Start from a template – Click Select template.  On the Mail Merge tab in the 
Select Template dialog box, select the template you want.  Then click OK. 

• Start from existing document – Start with any other existing document.  In the 
Start from existing box, select the document want, and then click Open.  If you 
don’t see the document, click More files, and then click Open, in the Open 
dialog box, locate the document you want and then click Open. 

5. Click Next: Select recipients at the bottom of the task pane. 

Step 3 

6. Under the Select recipients section, locate or create a data source and then select 
recipients.   

• Use an existing list – Click Browse….  In the Select Data Source dialog box, 
locate and click the data source you want.  By default, the My Data Sources 
folder opens.  Click Open.  Depending on the type of data source you select, 
other dialog boxes may appear asking you to request specific information.  All 
the entries in the data source appear in the Mail Merge Recipients dialog box, 
where you can refine the list of recipients to include in the merge. 

• Select from Outlook contacts – Click Choose Contacts Folder.  In the Select 
Contact List folder dialog box, click the contact list you want, and then click OK.  
All of the contacts in the folder appear in the Mail Merge Recipients dialog box, 
where you can refine the list of recipients to include in the merge. 

• Type a new list – Click Create….  In the New Address List dialog box, type the 
information you want to include for the first entry under Enter Address 
Information.  To complete the first entry and move on to a new entry, click New 
Entry.  Repeat these steps until you’ve added all the address entries you want 
and then click Close.  In the Save Address List dialog box, type a name for the 
address list in the File name box, and select a folder to save the list in.  By 
default, the address list is saved in the My Data Sources folder.  Click Save.  All 
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the contacts in your new list appear in the Mail Merge Recipients dialog box, 
where you can refine the list of recipients to include in the merge. 

Tip: You can use just about any type of data source you want for a 
mail merge.  Some examples include Microsoft Outlook 
Contact List, Microsoft Excel worksheet, Microsoft Access 
database, or other database files.  

7. Click Next: Write your letter at the bottom of the task pane. 

Step 4 

8. If you have not already done so, write your letter now.   

9. To add recipient information to your letter, click a location in the document, and then 
click one of the following items:   

• Address block… -- In the Insert Address Block dialog box, select the address 
elements you want to include and the formats you want.  Click OK.  If the Match 
Fields dialog box appears, Word may have been unable to find some of the 
information it needs for the address block. 

• Greeting line… -- Select the greeting line format, which includes the salutation, 
name format, and the following punctuation.  Select the text you want to appear 
in cases where Word can’t interpret the recipient’s name.  Click OK.  If the 
Match Fields dialog box appears, Word may have been unable to find some of 
the information it needs for the address block. 

• Electronic postage… -- In order to add electronic postage, you must first install 
an electronic postage program, such as one you purchased from a service on the 
World Wide Web. 

• Postal bar code… -- You must select a label or envelope type that supports the 
POSTNET bar code. More items… -- To select from address fields that will 
automatically map to corresponding fields in your data source, even if the data 
source’s fields don’t have the same name as your fields, click Address Fields.  
Or, select from fields that always take data directly from a column in a database 
by clicking Database Fields.  In the Fields box, click the field you want.  Click 
Insert, and then click Close.  If the Match Fields dialog box appears, Word may 
have been unable to find some of the information it needs for the address block. 
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Tip: You can add formatting (bold, italic, fonts, etc.) to your 
merged document.  To format merged data, you must format the 
merge fields in the main document.  Don’t format the data in the 
data source, because its formatting isn’t retained when you 
merge the data into the document.  In the main document, select 
the field containing the information you want to format, 
including the surrounding merge field characters (<< << >> >>). 

10. When you have finished writing your letter and adding the merge fields, you should 
save your document (File > Save As). 

11. Click Next: Preview your letters at the bottom of the task pane.  This allows you to 
preview and personalize each recipient’s letter if needed. 

Step 5 

12. Under the Preview your letters section, you can:  

• View each individually merged letter by clicking on the arrows next to the 
Recipient: number.   

• If there is a specific recipient that you want to view, you can click Find a 
recipient….  Enter the search criteria in the Find Entry dialog box. 

13. If necessary, fine-tune the recipient list. 

• Click Edit recipient list… if you need to make changes to your recipient list.  

• Click Exclude this recipient to exclude a particular recipient from the merge. 

14. When you have finished previewing your letters, click Next: Complete the merge. 

Step 6 

15. The Mail Merge Wizard is ready to produce your letters.  Under the Merge section, 
choose one of the following: 

• Print – print the letters.  The Merge to Printer dialog box appears allowing you 
to do one of the following: 

o To print all the documents, click All. 

o To print the document that you see in the document window, click 
Current record. 

o To print a range of documents, click From, and then type the record 
numbers in the From and To boxes. 

• Edit individual letters – to personalize the letters.  This opens a new document 
with the merged letters allowing you to edit the information you want in the 
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resulting merged document.  In the Merge to New Document dialog box, select 
the records you want to merge.  Click OK.  Your main document also remains 
open.  You can switch back to it if you want to make a change to all the 
documents.  Scroll to the information you want to edit and make your changes.  
Print or save the document just as you would any regular document.  Choose 
Print from inside this open document. 

• Previous: Preview your letters – to make changes to all the letters. 

Stopping and Resuming Mail Merge Wizard 
If you need to stop working on a mail merge, you can save the main document and 
resume the merge later.  Word keeps your place in the Mail Merge Wizard so that the 
next time you are in the document and open the Mail Merge Wizard, the task pane opens 
to the step where you left off. 

Creating and Printing Envelopes for a mass mailing 
using Mail Merge Wizard 

You can use the same data file you just used to print form letters to print the names and 
addresses on envelopes. 

1. Click on the Tools menu, point at Letters and Mailings, and then select Mail 
Merge….  The Mail Merge task pane appears. 

Step 1 

2. Under Select document type, click Envelopes.  The active document becomes the 
main document, even if it is blank.  This can be changed in Step 2 below. 

3. Click Next: Starting document at the bottom of the task pane.  

Step 2 

4. Under the Select starting document section choose how you want to set up your 
envelopes. 

• Create a new envelope - Click Change document layout.  Click Envelope 
options… under the Change document layout section.  In the Envelope 
Options dialog box, select the options you want, and then click OK.  The 
active document changes to represent an envelope. 

• Start with an existing envelope - Click Start from existing document.  In 
the Start from existing box, select the document containing the envelope you 
want, and then click Open.  If you don't see the document, click (More 
files…), and then click Open.  In the Open dialog box, locate the document 
you want, and then click Open.  The document is displayed.  

5. Click Next: Select recipients at the bottom of the task pane.  
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Step 3 

6. Under the Select recipients section, locate or create a data source and then select 
recipients. 

• Use an existing list - Click Browse….  In the Select Data Source dialog box, 
locate and click the data source you want.  (By default, Microsoft Word 
opens the My Data Sources folder.)  Once you have located the data source, 
click Open.  Depending on the type of data source you select, other dialog 
boxes may appear asking you to request specific information.  For example, 
if your data source is a Microsoft Excel worksheet that has information on 
multiple tabs, you need to select the tab containing the information you want.  
All the entries in the data source appear in the Mail Merge Recipients dialog 
box, where you can refine the list of recipients to include in the merge.  See 
instructions directly below on how to select the recipients you want to 
include.  

• Selecting from Outlook Contacts - Click Choose Contacts Folder.  In the 
Select Contact List folder dialog box, click the contact list you want, and 
then click OK.  All of the contacts in the folder appear in the Mail Merge 
Recipients dialog box, where you can refine the list of recipients to include in 
the merge.  All of the entries in the data source appear in the Mail Merge 
Recipients dialog box, where you can refine the list of recipients to include in 
the merge.  See instructions directly below on how to select the recipients 
you want to include. 

• Type a new list - Click Create….  In the New Address List dialog box, type 
the information you want to include for the first entry under Enter Address 
information; for example, title, names, and address information.  You don't 
have to fill in every field.  To complete the first entry and move on to a new 
entry, click New Entry.  Repeat this process until you've added all the 
address entries you want, and then click Close.  In the Save Address List 
dialog box, type a name for the address list in the File name: field, and select 
a folder to save the list in.  By default, the address list is saved in the My 
Data Sources folder. It's best to keep the address list here because this is also 
the default folder in which Microsoft Word looks for data sources. So if you 
want to use this address list in a later mail merge, you won't have to navigate 
through files and folders to locate it.  Click Save.  All of the contacts in your 
new list appear in the Mail Merge Recipients dialog box, where you can 
refine the list of recipients to include in the merge.  See instructions directly 
below. 

7. In the Mail Merge Recipients dialog box, select the recipients you want to print 
envelopes for.  

• Use the check boxes to designate recipients - This method is most useful if 
your list is short.  Select the check boxes next to the recipients you want to 
include, and clear the ones next to the recipients you want to exclude.  
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Tip: If you know you want to include most of the list in your merge, 
clicking Select All first makes it easy to clear particular records. 
Similarly, if you want to include only a few records in the list, 
click Clear All, and then select the records you want. 

• Sort items in the list - This is useful if you want to see items in alphabetical or 
numeric order.  Click the column heading of the item you want to sort by.  or 
example, if you want to display the list alphabetically by last name, click the 
Last Name column heading.  

• Filter items in the list - This is useful if the list contains records that you know 
you don't want to see or include in the merge.  Once you've filtered the list, you 
can use the check boxes to include and exclude records as described in the 
previous section.  Click the arrow next to the column heading of the item you 
want to filter by.  

Click any of the following:  

o (Blanks) -- Displays all the records in which the corresponding field is 
blank.  

o (Nonblanks) -- Displays all the records in which the corresponding field 
contains information.  

o (Special conditions) -- If your data source contains records that share the 
same information, and there are ten or fewer unique values in the 
column, you can filter by specific information. For example, if there are 
multiple addresses that list Australia as the country/region, you can filter 
on Australia.  

o (All) – Displays all the records again.   

o (Advanced…) -- For advanced sorting and filtering. Use the Filter 
Records and Sort Records tabs to set up the sorting or filtering query 
you want.  

Click OK to return to the Mail Merge Wizard.  Microsoft Word will use the 
recipients you designated for the merge.  

8. Click Next: Arrange your envelope at the bottom of the task pane.  

Step 4 

9. If you are not in print layout view, switch to it (View menu > Print Layout).  

10. If you want to include a return address on your envelope, type it in the upper-left 
corner.  

11. Click in the center of the envelope to insert a text box.  Insert merge fields where you 
want to merge names, addresses, and other information such as a postal bar code.  
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• Address block… -- In the Insert Address Block dialog box, select the address 
elements you want to include and the formats you want, and then click OK.  An 
<<AddressBlock>> variable is inserted where the name, address, and other 
information will appear. 

Note: If the Match Fields dialog box appears, Microsoft Word may 
have been unable to find some of the information it needs for the 
address block. Click the arrow next to (not available), and then 
select the field from your data source that corresponds to the 
field required for the mail merge. 

• Electronic postage… -- In order to add electronic postage, you must first install 
an electronic postage program, such as one you purchased from a service on the 
World Wide Web.  If you do not have an electronic postage program installed, 
Microsoft Word prompts you to install one and offers to connect to the Microsoft 
Office Website.  There you can get more information and links to other sites that 
offer electronic postage.  Insert the postage according to the program's 
instructions.  

• Postal bar code… -- You must select a label or envelope type that supports the 
POSTNET bar code.  In the Insert Postal Bar Code dialog box, select the 
appropriate address fields.  Repeat this process until all the fields you want are 
inserted. 

Note: The Postal bar code option only appears if you are using the 
U.S. language version of Microsoft Word. 

• More items… -- allows you to insert other fields of information.  The Insert 
Merge Field dialog box appears. 

Under the Insert: section select:  

o Address Fields -- Select from address fields that automatically map to 
corresponding fields in your data source, even if the data source's fields 
don't have the same name as your fields.  

o Database Fields -- Select from fields that always take data directly from 
a column in a database.  

In the Fields: section, click the field you want and click Insert.  Repeat this until 
all the fields you need are placed.  Then click Close.  

If the Match Fields dialog box appears, Microsoft Word may have been unable 
to find some of the information it needs to insert the field. Click the arrow next to 
(not available), and then select the field from your data source that corresponds 
to the field required for the mail merge.  
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Note: If you insert a field from the Database Fields list, and then later 
switch to a data source that doesn't have a column with the same 
name, Word won't be able to insert that field information into 
the merged document. 

12. After you've completed the main document and inserted all of the merge fields, click 
Save As on the File menu.  Name the document, and then click Save.  

13. Click Next: Preview your envelopes at the bottom of the task pane.  

Step 5 

14. Now you’re ready to preview your envelopes and fine-tune the recipient list.  To 
preview the items in order, click the arrow buttons.  To locate and preview a specific 
item, click Find a recipient…, and then enter the search criteria in the Find Entry 
dialog box.  

15. If necessary, you can fine-tune the recipient list.  

• To exclude a particular recipient from the merge, click Exclude this recipient.  

• To change the list of recipients, click Edit recipient list, and then make your 
changes in the Mail Merge Recipients dialog box.  

16. Click Next: Complete the merge at the bottom of the task pane.  

Step 6 

17. You are ready to complete the merge and produce your envelopes.  Under the Merge 
section, do one of the following. 

• Print the envelopes -- In the Merge to Printer dialog box, do one of the following, 
and then click OK. 

o To print all the documents, click All.  

o To print the document that you see in the document window, click 
Current record.  

o To print a range of documents, click From, and then type the record 
numbers in the From and To boxes.  

In the Print dialog box, select the options you want.  

Additional Features: 

Personalize individual envelopes 

To personalize individual documents, you actually complete the merge, and then edit the 
information you want in the resulting merged document.  
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Click Edit individual envelopes.  

In the Merge to New Document dialog box, select the records you want to merge. 

Click OK. 

Microsoft Word creates and opens a new merged document. Your main document also 
remains open, and you can switch back to it if you want to make a change to all the 
documents.  

Scroll to the information you want to edit, and make your changes. 

Print or save the document just as you would do with a regular document. 

 

Save the envelopes for later use 

If you want to edit merged envelopes or save them for later use, you can collect them into 
a single document. 

Click Edit individual envelopes.  

In the Merge to a New Document dialog box, do one of the following, and then click 
OK.  

To merge all the documents, click All.  

To merge only the document that you see in the document window, click Current 
record.  

To merge a range of documents, click From, and then type the record numbers in the 
From and To boxes.  

Microsoft Word opens a single new document that contains all the individual documents. 
You can then save the document for later use, just as you would any regular document.  

Getting Additional Help 
Information Services provides consulting and Q&A help in a variety of ways: 

785/864-0200 
question@ku.edu 
www.ku.edu/~helpdesk

Last Update: 3/5/2007 
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